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Overview
Overview

■ Introduction — page 2

■ Two Conventions — page 2

■ SNiFF+ Documentation — page 2

■ Contact Information — page 3

■ Useful Links — page 3
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1.1 Introduction

Thank you for choosing SNiFF+!

This guide describes how to install SNiFF+, as well as license manage-
ment configuration. It also provides simple step-by-step instructions for
importing your own code or the sample code into SNiFF+. We suggest
that you then go through the SNiFF+ Beginner’s Guides which provide an
introduction to the key features of SNiFF+ and their use in application
development.

1.2 Two Conventions

The terminology below is used throughout this guide and in all SNiFF+
documentation.

■ SNIFF_DIR4

This refers to your SNiFF+ installation directory.

■ “Choose the MenuCommand from the MenuName” is presented as:

Choose MenuName > MenuCommand.

1.3 SNiFF+ Documentation

Please refer to the SNiFF+ Release Notes for important, late-breaking
information on the current release.

If you choose to install the SNiFF+ documentation files, the documenta-
tion set will be available online and as .pdf files.

Please refer to The SNiFF+ Documentation Set—Guidelines — page 52
for a few guidelines as to what you can expect to find where in the docu-
mentation.
2
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1.4 Contact Information

Feedback

Your feedback is always very welcome.

Please send feedback to one of our support e-mail addresses.

■ Europe

support-ec@windriver.com

■ USA

support@windriver.com

Licenses

■ To obtain an Evaluation license, please contact your local Windriver sales
office or send an email to:

inquiries@windriver.com

■ To obtain a Product License, please contact your local Windriver sales
office or send an email to:

license@windriver.com

1.5 Useful Links

■ A number of useful links (Knowledge Base, FAQs, User’s Mailing List ...)
are available under:

http://www.windriver.com/sniff
3
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System Requirements
Overview

■ Supported Platforms — page 6

■ Minimum System Requirements — page 6

● Required Disk Space — page 6

● Memory Required — page 7

● Diskspace for Files Generated by SNiFF+ — page 7
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2.1 Supported Platforms

Windows

■ Windows NT (Intel)

■ Windows 2000 (Intel)

Not Supported: Windows 3.1, Windows 95/98 and Windows ME

Unix

■ Solaris 2.5 or later (SPARC)

■ Linux 2.x glibc 2.1

■ HP-UX 10.20 or later

■ IBM AIX 4.2 or later (PowerPC)

2.2 Minimum System Requirements

The system requirements were obtained from tests conducted on a Win-
dows NT host and on a Unix host—Solaris workstation.

2.2.1 Required Disk Space

Figure 2-1 Disk Space

Installed SNiFF+ Diskspace -
Windows

Diskspace -
Unix

Complete installation ~ 67 MB ~ 100 MB

.pdf files ~ 7 MB ~ 6 MB

Example sources for tutorials ~ 2 MB ~ 2,5 MB

Installation for each additional
platform

~ 60 MB
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2.2.2 Memory Required

Memory required for a Project with approx. 85 KLOC:

Figure 2-2 Memory

When using the SNiFF+ C/C++ parser to parse large projects, we recom-
mend a minimum memory size of 256 MB.

2.2.3 Diskspace for Files Generated by SNiFF+

The diskspace required for files generated by SNiFF+ depends on the
number of symbols in your source code but is usually not larger than the
diskspace required for the sources.

State Memory -
Windows

Memory - Unix

SNiFF+ empty process ~ 10 MB ~ 20 MB

After loading project Symbols ~ 18 MB ~ 27 MB

After one cross reference (Ref-
erenced By query)

~ 22 MB ~ 28 MB
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Preparation
Overview

■ Package Contents — page 10

■ Before You Start — page 10

■ Locate the Installation Key — page 11

■ Select a Location for Installation — page 11
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3.1 Package Contents

■ CD-ROM — the CD contains both software and documentation:

● Software: the CD contains SNiFF+ for all platforms and targets.

● Documentation, including manuals, release notes and application
papers, in formats suitable for both browsing online and printing.

■ Hardcopy manuals — manuals for the selected language are shipped
with each package.

3.2 Before You Start

Be sure that you are installing SNiFF+ on a supported host that meets
minimum system requirements. See System Requirements — page 5 for
a complete list of supported host systems and their minimum configura-
tion requirements.

The SNiFF+ online help system requires a web browser installed on the
host system, either Netscape Communicator version 4.x or higher (Unix
hosts) or Internet Explorer 4.x or higher (Windows hosts).

If you plan to install SNiFF+ on a system with an existing installation of
SNiFF+ (for example, a Beta version) you must first uninstall the existing
installation. See the SNiFF+ Release Notes for step-by-step instructions.
10
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3.3 Locate the Installation Key

The SNIFF_LITE and SNIFF_LITE_PRO licenses are delivered with
SNiFF+. These licenses allow you to work with the SNiFF+ example
code only. So you don’t need a license key to get SNiFF+ up and run-
ning.

However to work with your own code, you need either an Evaluation
license - this license is not locked to a specific machine and is valid for a
restricted period of time (see Obtaining an Evaluation License — page
32), or a Product license (see Obtaining a Product License — page 33).

If you’ve already obtained an Evaluation or Product license key, you can
either enter this string in the License dialog that appears during installa-
tion, or append this string to SNIFF_DIR4\license.dat in the
SNiFF+ root directory, or add it to an existing FLEXlm product license
file.

3.4 Select a Location for Installation

On Unix systems we suggest that the administrator (super-user) install
SNiFF+ in a central location, e.g., /usr/local/sniff.

Note

Uncomment any existing FEATURE lines for SNIFF_LITE and
SNIFF_LITE_PRO.
11
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Overview

■ Introduction — page 14

■ Scenario — page 14

■ Installation from Website or CD-ROM — page 15

■ Server Installation — page 15

● Client Installation — page 16

■ Local Installation — page 16

■ Installation Steps — page 17

● Step 1: Welcome — page 17

● Step 2: License Agreement — page 17

● Step 3: Customer Information — page 17

● Step 4: Specify the Installation Directory — page 17

● Step 5: License Key — page 17

● Step 6: Tornado SNiFF+ Integration — page 17

● Step 7: Setup Type — page 18

● Step 8: Ready to Install the Program — page 18

● Additional Information — page 18

■ License SNiFF+ for Windows — page 18

■ Start SNiFF+ for Windows — page 19

■ Download Additional GNU Tools — page 19
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4.1 Introduction

This chapter provides step-by-step instructions to be read as you install
SNiFF+ for Windows.

Before running the illustration program, be sure to exit from any other
software and stop all virus scan software.

4.2 Scenario

Installing SNiFF+ involves the steps shown in the Install SNiFF+ for Win-
dows flowchart. Each of these steps will be discussed in detail later.

Figure 4-1 Install SNiFF+ for Windows

Server Installation

License?, see
Licensing

Local Installation

Follow instructions
in InstallShield
Wizard

Follow instructions
in InstallShield
Wizard

Client Installation

Installation from
Website or CD-ROM

Start SNiFF+
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4.3 Installation from Website or CD-ROM

The installation of SNiFF+ for Windows assumes familiarity with the Win-
dows NT/2000 operating system and is based on the Microsoft Installa-
tion Service.

You can download SNiFF+ from the Wind River website, http://www.win-
driver.com/sniff/download or install SNiFF+ from our CD-ROM.

Now follow the steps in either Server Installation — page 15 or in Local
Installation — page 16.

4.4 Server Installation

We suggest that your System Administrator install SNiFF+ on the Server
machine.

1. From the Start menu, choose Run...

2. In the Run dialog that appears, use the Browse... button to navigate to
your executable:

setup.exe

3. In the Open field, add /a after setup.exe, the entry in the Open field
should now be

setup.exe /a

The InstallShield Wizard appears.

4. In the InstallShield Wizard, enter the Server location where you want to
install SNiFF+ and follow the steps in the InstallShield Wizard, see Instal-
lation Steps — page 17.

Once this is over, the SNiFF+ files are copied over to the Server location
specified above. Please note that no environment variables are set and
no registry entries are added. This will be done for each client installa-
tion, see below.
15
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4.4.1 Client Installation

■ Navigate to the Root directory of the network installation and double-click
on the .msi file. This will install SNiFF+ and set the necessary environ-
ment variables and registry entries on your client machine. These envi-
ronment variables will then access the SNiFF+ installation which is
physically located on the Server machine.

4.5 Local Installation

1. Insert the SNiFF+ CD-ROM in the drive. The setup.exe program
starts automatically (depending on your configuration).

If the executable does not start automatically:

In your Windows Explorer, navigate to the CD-ROM drive and double-
click on setup.exe.

setup.exe installs the selected SNiFF+ for Windows packages and
copies all required files to the installation root directory. It can also set up
a program group for SNiFF+ and set all necessary registry entries.

Important
To uninstall packages, use the Add/Remove Programs option in the
Control Panel.

2. Follow the steps in the InstallShield Wizard that appears, see Installation
Steps — page 17.

Note

The SNiFF+ installation is based on the Microsoft Installation Service.

If this service is not installed on your computer, SNiFF+ will install it for
you. A reboot will be necessary.
16
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4.6 Installation Steps

4.6.1 Step 1: Welcome

To continue, click Next.

4.6.2 Step 2: License Agreement

Read the license agreement. If you agree with its conditions, click I
accept the terms in the license agreement and Next to proceed with
installation.

4.6.3 Step 3: Customer Information

Enter the primary user name, your organization name, and select
whether you are installing SNiFF+ for a single User or for multiple Users.
To continue, click Next.

4.6.4 Step 4: Specify the Installation Directory

Click Next to install to the default directory, or click Change... to install to
a different directory and then click Next.

4.6.5 Step 5: License Key

If you have an Evaluation or Product license key, you can enter it here or
you can later append this string to SNIFF_DIR4\license.dat in the
SNiFF+ root directory, or add it to an existing FLEXlm product license
file.

For more information, see Licensing — page 31.

4.6.6 Step 6: Tornado SNiFF+ Integration

If you’re interested in the Tornado SNiFF+ integration, read the setup
notice and click Next.
17
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4.6.7 Step 7: Setup Type

Choose the setup type that best suits your needs and click Next.

4.6.8 Step 8: Ready to Install the Program

Click Install to begin the installation.

When SETUP has finished installing SNiFF+, a dialog confirms installa-
tion.

Click Finish to close the InstallShield Wizard.

Congratulations! You have installed SNiFF+.

4.6.9 Additional Information

Temporary Files
Please note that temporary files are stored in the system temp directory.

Registry Entries
Only the absolutely necessary changes (e.g., program manager group)
are stored in the registry.

User Profiles
User profiles are stored in the directory

SNIFF_DIR4\config\Profiles\<user_name>\

4.7 License SNiFF+ for Windows

You don’t need a license for working with SNiFF+ demo projects.

If you want to evaluate SNiFF+ for your own projects and haven’t already
entered a license key in the InstallShield Wizard, you need to append
your license key to SNIFF_DIR4\license.dat in the SNiFF+ root
directory, or add it to an existing FLEXlm product license file.

If you do not have a license key, see Licensing — page 31.
18
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4.8 Start SNiFF+ for Windows

To start SNiFF+ immediately thereafter, you have two options:

■ Start SNiFF+ from the associated program group.

or

■ At the command prompt, enter

sniffstart.cmd

In both cases, a batch file is started which runs sniff.exe.

4.9 Download Additional GNU Tools

The GNU tools that you need to work with SNiFF+ are delivered as part
of the SNiFF+ package.

You can download additional GNU tools which you may need from the
GNU web site:

http://www.gnu.org

Local Installation

Apart from running sniff.exe, SNiFF+ automatically sets the neces-
sary environment variables for the current SNiFF+ session only:

SNIFF_DIR4 - Defines the SNiFF+ for Windows installation directory

PATH - Includes the SNiFF+ for Windows executables directory in
your PATH
19
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5.1 Introduction

This chapter provides step-by-step instructions to be read as you install
SNiFF+ for Unix.

Before running the installation program, be sure to exit from any other
software and stop all virus scan software.

5.2 Scenario

Installing SNiFF+ involves the steps shown in the Install SNiFF+ for Unix
flowchart. Each of these steps will be discussed in detail later.

Figure 5-1 Install SNiFF+ for Unix

Installation from Web-
site or CD-Rom

Run the Installation
Script - follow instruc-
tions on screen

License? See
Licensing

Environment Vari-
ables

Start SNiFF+ for
UNIX
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5.3 Installation from Website or CD-Rom

The installation of SNiFF+ for Unix assumes familiarity with one or more
of the supported platforms (Solaris, Linux, AIX and HP-UX).

You can

■ download SNiFF+ from the Wind River website, http://www.win-
driver.com/sniff/download. You can then go ahead and run the installation
script, see Run the Installation Script — page 25 or

■ install SNiFF+ from our CD-ROM, see Installation from CD-ROM — page
23.

5.4 Installation from CD-ROM

You must have the appropriate user privileges for mounting the CD-ROM,
creating a SNiFF+ root directory and for copying the files from the media.
If you plan to use SNiFF+ in a team environment we recommend that you
install SNiFF+ as the user who will later be the administrator for SNiFF+.

To load the SNiFF+ packages from CD-ROM, follow the steps below and
refer to the following sections for instructions specific to your platform.

Note

If you are installing the GNU binaries, these must be installed in
/usr/local. Root privileges are required for installing the bi-
naries!
23



SNiFF+/SNiFF+ PRO 4.0.1
Getting Started
5.4.1 Insert CD-ROM and Mount the CD-ROM Drive

Please follow the platform-specific commands below. All steps refer to
the directory /cdrom as the mount point.

Solaris 2.5 or Later

Enter the following to create the mount point and mount the CD-ROM
drive:

mkdir /cdrom

mount -r -f hsfs /dev/dsk/c0t6d0s0 /cdrom

Linux 2.x glibc 2.1

Enter the following to create the mount point and mount the CD-ROM
drive:

mkdir /cdrom

mount -r /dev/cdrom /cdrom

HP-UX 10.20 or Later

Enter the following to create the mount point and mount the CD-ROM
drive:

/bin/mkdir /cdrom

/etc/mount -r /dev/dsk/c1d0s2 /cdrom

In the above example, the CD-ROM device has the device address 2. If
the CD-ROM has not been successfully mounted after the execution of
the above instructions, ask your system administrator to mount the CD-
ROM drive using sam.

IBM AIX 4.2 or Later

Select available CD-ROM drives on your system:

/etc/lsdev -C -c cdrom -H

The first field of the resulting output string is the device name of the CD-
ROM drive in /dev, e.g., /dev/cd0
Create the mount point for the CD-ROM drive:

/bin/mkdir /cdrom

Mount the CD-ROM drive:

/etc/mount -vcdrfs -r /dev/cd0 /cdrom
24
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If the CD-ROM has not been successfully mounted after the execution of
the above instructions, ask your system administrator to mount the CD-
ROM drive using smit.

Install SNiFF+ from a CD-ROM Drive on Windows

Copy the following files and the platform specific subdirectory from the
CD-ROM drive to a temporary directory on the platform where you intend
to install SNiFF+:

Install_kit

Sniff.tgz

Doc.tgz

Example.tgz

Now run the installation script, see Run the Installation Script — page 25.

5.5 Run the Installation Script

■ Website

If you’ve downloaded SNiFF+ from the Wind River website, change to the
directory in which you downloaded the files.

For all platforms, enter:

csh ./install.kit

and follow the instructions on screen, see Installation Steps — page 26.

Note

If you don’t want to copy the entire platform specific subdirectory,
you should at least copy the compulsory Sniffbin.tgz, Gzcat
and Tar files and other optional files that you may need from this
subdirectory.
25
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■ CD-ROM

Change to the directory where you have mounted the CD-ROM, e.g.:

cd /cdrom

Or change to the temporary directory in which you copied the files from
the CD-ROM, see Install SNiFF+ from a CD-ROM Drive on Windows —
page 25.

For all platforms, enter:

csh ./install.kit

and follow the instructions on screen, see Installation Steps — page 26.

5.6 Installation Steps

5.6.1 Step 1: License Agreement

You must accept the license agreement to continue.

5.6.2 Step 2: Binaries to Install

During installation, you can select the individual binaries (SNiFF+, GNU,
FlexLM, Integrations) to be installed on your system.

The GNU packages for all platforms MUST reside in the directory /usr/
local. Installation of the GNU packages requires write permission for
the resident directory.

To download GNU tools other than those delivered with SNiFF+, refer to:

http://www.gnu.org/software

Note

In order for RCS to work properly, GNU diff must be installed. GNU diff
is supplied with the RCS package on the SNiFF+ CD-ROM. If you
have already installed RCS, please verify that diff is available.
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5.6.3 Step 3: Host Platform(s)

SNiFF+ can be installed in a single directory for multiple platforms
(Solaris, Linux, AIX and HP-UX) by installing the binaries for the required
platforms in one step. All platform-specific files are placed into platform
specific subdirectories that are automatically created by the installation
script. When starting SNiFF+ from this directory, the host platform is
detected automatically and the appropriate executables are started.

5.6.4 Step 4: Installation Platform

Select the platform where the installation process is running.

5.6.5 Step 5: Installation Directory

The installation procedure prompts you for the full path name of the
SNiFF+ root directory and creates it if necessary. You require write per-
mission for this directory.

5.6.6 Step 6: SNiFF+ Packages to Install

During installation, you can select the individual SNiFF+ packages (Bina-
ries for selected target platform(s), example sources and documenta-
tion) to be installed on your system. You will then see a summary of the
packages you’ve chosen to install as well as the size of each package.
Confirm this to continue. SNiFF+ will then install all chosen packages.

5.6.7 Step 7: License Key

If you have an Evaluation or Product license key, you can enter it here or
you can later append this string to SNIFF_DIR4\license.dat in the
SNiFF+ root directory, or add it to an existing FLEXlm product license
file.

For more information, see Licensing — page 31.
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5.6.8 Step 8: Installation Verification

After the packages have been installed, the installation procedure asks
you whether it should check to see if the installation was successful.

The script determines whether all necessary files have been installed
and checks the access rights.

We suggest you let the installation procedure verify that the installation
was successful.

If you need to install other packages, go ahead and do so now by follow-
ing the instructions on screen.

5.7 License SNiFF+ for UNIX

You don’t need a license for working with SNiFF+ demo projects.

If you want to evaluate SNiFF+ for your own projects and haven’t already
entered a license key during the installation procedure, you need to
append your license key to SNIFF_DIR4/license.dat in the
SNiFF+ root directory, or add it to an existing FLEXlm product license
file.

If you do not have a license key, see Licensing — page 31.

5.8 Environment Variables

The following environment variables need to be set.

SNIFF_DIR4 (Unix Only)

This environment variable must point to the root of your sniff installation
directory and is referred to as $SNIFF_DIR4.
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PATH (Unix Only)

Set your PATH environment variable to:

set path = SNIFF_DIR4/bin $path (for csh)

PATH=SNIFF_DIR4/bin:$PATH;

export PATH (for sh or ksh)

If you have installed the GNU products, your path must contain /usr/
local/bin.

LM_LICENSE_FILE (Optional)

The $LM_LICENSE_FILE variable needs to be set only if the
license.dat file is not in its default location in the SNiFF+ root direc-
tory or if you want to use an already existing FLEXlm product license file.

setenv LM_LICENSE_FILE

<any_location>/license.dat(for csh)

LM_LICENSE_FILE=<any_location>/license.dat;
export LM_LICENSE_FILE (for sh or ksh)

SNiFF+ can also be configured to use a specific license file by a
command line option.

As is true for any other X Windows application, the $DISPLAY variable
must be set to point to the X server where you would like the SNiFF+
windows to appear.

5.9 Start SNiFF+ for UNIX

Once the environment has been set, you can start SNiFF+ by entering:

sniff &
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6.1 Licensing—Overview

The SNIFF_LITE and SNIFF_LITE_PRO licenses are delivered with
SNiFF+. These licenses allow you to work with the SNiFF+ sample code
only. You can switch to the SNIFF_LITE_PRO license to build and
debug SNiFF+ sample code.

To work with your own code, you can request:

■ an Evaluation license - this license is not locked to a specific machine and
is valid for a restricted period of time, see Obtaining an Evaluation
License — page 32.

■ a Product license, see Obtaining a Product License — page 33.

6.1.1 Obtaining an Evaluation License

You can ask for an evaluation license without having to supply any details
about your configuration.

1. You can obtain an evaluation license string from the local Wind River
sales office or by sending an email to:

inquiries@windriver.com

After requesting the license, you will receive the license string by either
e-mail or fax.

2. You can either enter this string in the License dialog that appears during
installation, or append this string to SNIFF_DIR4\license.dat in
the SNiFF+ root directory, or add it to an existing FLEXlm product license
file.
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6.1.2 Obtaining a Product License

1. After the purchase, complete the license request form
license_key_request.txt in your SNiFF_DIR4/docs direc-
tory and email it to:

license@windriver.com

to receive your permanent product keys.

Maintenance customers: to upgrade your SNiFF+ 3.x license keys,
complete the license upgrade form
license_upgrade_request.txt in your SNiFF_DIR4/docs
directory and email it to:

license@windriver.com

In these forms, you will need to specify the host id of the machine that is
going to be your license server (see Determining the host id — page 33).

After requesting the license, you will receive the license string by either
e-mail or fax.

2. You can either enter this string in the License dialog that appears during
installation, or append this string to SNIFF_DIR4\license.dat in
the SNiFF+ root directory, or add it to an existing FLEXlm product license
file.

Determining the host id

On Windows
You can obtain the host id for your machine by entering the following
command at the command prompt:

SNIFF_DIR4\bin\Lmutil lmhostid

The Lmutil program determines the host id on Windows computers by
selecting the ethernet card id.

Caution: If you get the message "The FLEXlm host ID of this machine is
00000000" or "ffffffff," install IPX/SPX protocol.

If your computer does not have an Ethernet card installed, please, con-
tact Wind River Support.

United States:

support@windriver.com

Note

SNIFF_DIR4 refers to your SNiFF+ installation directory.
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Europe:

support-ec@windriver.com

On Unix
You can obtain the host id of the machine that is going to be your license
server by doing the following:

1. On the machine that is going to be your license server, start SNiFF+.

2. From the menu, choose Help > Feedback...

3. In the dialog that appears, click the Sniff Info... button.

4. In the Sniff Info dialog that appears, scroll down to - FlexLM Hostid
and send this entire section containing the hostid to

license@windriver.com

6.2 Evaluation License

The evaluation license is not locked to a specific machine and is valid
until its expiration date.

In the example below, a backslash at the end of a line, followed by an
indented line, indicates line-continuation.

Note: If you are already using FLEXlm for other products you can still
use the SNiFF+ evaluation string if you keep it in a separate file from
your existing product license and modify the environment variable
LM_LICENSE_FILE for FLEXlm accordingly.

E.g., copy the SNiFF+ evaluation string into license.dat and set
LM_LICENSE_FILE to the following:

LM_LICENSE_FILE=
<path_to_existing_license>;SNIFF_DIR4/license.dat

Evaluation license file example

FEATURE SNIFF_EVAL wrsd 4.0 31-dec-2000 uncounted A303CFAECE79 \
HOSTID=DEMO ck=168

FEATURE SNIFF_EVAL_PRO wrsd 4.0 31-dec-2000 uncounted 5E468CC1C97B \
HOSTID=DEMO ck=138
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Caution: Do NOT start the license server when working with an evalua-
tion license only.

6.3 Product License

SNiFF+ comes with the FLEXlm floating license server. The license
server, which is node-locked, keeps track of the number of concurrent cli-
ents and makes sure that all licenses are current. Client licenses may
float across the network. You need a license for every concurrent SNiFF+
user. This license comes in the form of an ASCII text string.

You may change only three fields in the license.dat file:

■ The hostname in the SERVER line

■ The TCP port number in the SERVER line

■ The path of the wrsd executable in the VENDOR line:

IMPORTANT: Edit the VENDOR line by entering the full path to the used
wrsd executable, e.g.

On Windows

VENDOR wrsd c:\sniff\bin\Wrsd.exe

Note

Uncomment any existing FEATURE lines for SNIFF_LITE and
SNIFF_LITE_PRO.

Product license file example

SERVER earth 809f1868 7590
VENDOR wrsd c:\sniff\bin\Wrsd.exe
FEATURE SNIFF wrsd 4.0 permanent 5 0CFDBC1DB488 ck=159
FEATURE SNIFF_PRO wrsd 4.0 permanent 5 FC88C7B8D9CB ck=180
FEATURE SNIFF_CPP wrsd 4.0 permanent 5 7F02E345DDBE ck=136
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VENDOR wrsd c:\sniff\bin\

IMPORTANT: Do not change any other fields, otherwise the license will
not be valid!

Furthermore, if you already use software licensed with FLEXlm, you will
have to merge the various license files.

The resulting license file must consist of one SERVER line (or more for
multi-server configurations), followed by any number of VENDOR lines,
which in turn are followed by any number of FEATURE lines. Be careful
not to mix VENDOR and FEATURE lines. Moreover, you should always
use the latest version of Lmgrd supplied with the various products
licensed with FLEXlm.

To find out what the version number of your Lmgrd is, enter the following
command:

On Windows

SNIFF_DIR4\bin\Lmgrd.exe -v

On Unix

lmgrd -v

6.4 FLEXlm License Manager

You will need to determine where your license server runs, either locally
or on a server in the network.

If your license server runs locally, you must first configure your license
server and then start it. For details, see Configuring the FLEXlm License
Manager (Windows Only) — page 37.

If your license server runs on a server in the network, all you have to do
is set your LM_LICENSE_FILE environment variable to point to it. For
details, see LM_LICENSE_FILE Environment Variable — page 39.

Note

Uncomment any existing FEATURE lines for SNIFF_LITE and
SNIFF_LITE_PRO.
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6.4.1 Configuring the FLEXlm License Manager (Windows Only)

To configure the FLEXlm License Manager

1. Copy the file

SNIFF_DIR4\bin\Flexlm.cpl

to your system directory (if it is not already there). On Windows 2000 and
on Windows NT, this is typically

C:\winnt\system32

2. Verify that there are other files with the file extension cpl in the directory.

3. From the Start menu, select Control Panel and click on the FLEXlm icon
and configure the license server. You can configure the license server to
be automatically started whenever the server machine is booted. For
more information please refer to the file:

SNIFF_DIR4\docs\Readflex.wri

Note: When running the FLEXlm License Manager as a service, we
recommend that you copy the following files from the
SNIFF_DIR4\bin directory

Flexlm.cpl

Lmgrd.exe

Lmutil.exe

Wrsd.exe

to another location and run the license daemon from there. This makes
removing or upgrading SNiFF+ for Windows much easier without
affecting the license manager daemon setup.

6.4.2 Starting the License Server

You must start the license server before using SNiFF+ with a product
license.

Caution

Do NOT start the license server when working with an evaluation li-
cense or a SNIFF_LITE/SNIFF_LITE PRO license.
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On Windows

The license server is located in

SNIFF_DIR4\bin

You can do this in two ways. Either manually, by entering

lmgrd -app -c SNIFF_DIR4\license.dat

or automatically as follows:

In the FLEXlm Control Panel, select the Start Server at Power Up box.
For more information, please refer to the previous section, Configuring
the FLEXlm License Manager (Windows Only) — page 37.

Note: This is possible for both Windows 2000 and Windows NT. How-
ever, on Windows NT also select the Use NT Services box.

Before using the automatic start-up service, try starting the license
server manually in order to see any error messages. If there aren't any, it
is safe to start the license server automatically.

On Unix

The license server is located in SNIFF_DIR4/bin. Any user can start
the server, but we suggest that you start the license server automatically
at boot-up.

In the following, a backslash at the end of a line, followed by an indented
line, indicates line-continuation.

license.log specifies the log file where license transactions and
error messages are written into. At each start-up of the license server,
the file is overwritten. If the license server is not running, read the mes-
sages that appear on the terminal or are written into the log file.

Command line syntax for the license server

SNIFF_DIR4/bin/lmgrd -c SNIFF_DIR4/license.dat > \
SNIFF_DIR4/license.log &

Starting the license server at boot-up from the rc.local file

For BSD, append the following line to /etc/rc.local

(for UNIX-V, append it to the directory /etc/rc3.d):

SNIFF_DIR4/bin/lmgrd -c SNIFF_DIR4/license.dat > \
SNIFF_DIR4/license.log&
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6.4.3 Checking the Active License Server

The lmstat program provides information about the status of the
license server and the users that have active licenses.

For status information about the running server, enter the following at the
command prompt:

On Windows
In the following, a backslash at the end of a line, followed by an indented
line, indicates line-continuation.

SNIFF_DIR4\bin\Lmutil lmstat -a -c \
SNIFF_DIR4\license.dat

or select Status in the FLEXlm Control Panel.

On Unix

SNIFF_DIR4/bin/lmstat -a -c \
SNIFF_DIR4/license.dat

You can also get license server information from within SNiFF+ by choos-
ing the License... command in the Project Browser’s Help(?) menu.

6.4.4 LM_LICENSE_FILE Environment Variable

On Windows

The %LM_LICENSE_FILE% environment variable needs to be set only
if the license.dat file is not in SNIFF_DIR4 or the default location
C:\FLEXlm\. In this case, set the %LM_LICENSE_FILE% to the full
path and filename of the license file.

You can either temporarily change the environment variable at the com-
mand prompt by using the set command, or permanently set the envi-
ronment variable in the System applet in the Windows Control Panel or if
you know your port number, you can enter this together with the host-
name, eg., 7500@earth.

On Unix

The $LM_LICENSE_FILE environment variable needs to be set only if
the license.dat file is not in SNIFF_DIR4. In this case, set the
$LM_LICENSE_FILE to the full path and filename of the license file.

You can either temporarily change the environment variable at the com-
mand prompt or set it permanently in your shell initialization files eg.,
cshrc.
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6.4.5 FLEXlm User Manuals

The FLEXlm online user documentation can be found at the following
location:

http://www.globetrotter.com/manual.htm

Globetrotter Inc. in California, USA
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7.1 Introduction

This part of the guide is designed to show you how to get either your
code or the C++ sample code into the SNiFF+ environment as quickly as
possible. You will first start SNiFF+ and then either load your own code or
the sample code into SNiFF+ by using the Project Creation Wizard.

7.2 Start SNiFF+

You can run SNiFF+ from a HP-UX, Solaris, AIX, Linux, or a Windows
host. The following instructions start SNiFF+.

HP-UX, Solaris, AIX and Linux Host

■ Make sure you have set the SNIFF_DIR4 environment variable.

■ At the command prompt, type

sniff &

Windows Host

■ From the Start menu, choose Programs > SNiFF+ 4.0.1 > Start SNiFF+
4.0.1 for Windows.
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7.3 Welcome to SNiFF+ Dialog

When you run SNiFF+ for the first time, the Welcome to SNiFF+ dialog
appears. You can open it with Help > Welcome to SNiFF+...

This dialog allows you to

■ quickly import source code into SNiFF+ by using the Project Creation
Wizard.

■ open the SNiFF+ C++/Java Beginner’s Guides or the Tornado Integration
Guide.

■ open a Project from the list of last opened Projects (if any).

■ open initial SNiFF+ screen by pressing Continue.

In this dialog, you can also choose the product you want to test, SNiFF+
or SNiFF+ PRO, the main difference is that SNiFF+ PRO includes build
and debug support and you need an appropriate license for each prod-
uct.

The SNIFF_LITE and SNIFF_LITE_PRO licenses are delivered with
SNiFF+. These licenses allow you to work with the SNiFF+ sample code
only, provided you do not change the structure of the Project once gener-
ated.

Let’s get started by importing source code into SNiFF+!
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7.4 Import Code with Wizard

You can either import your own source code into SNiFF+ (if you have an
Evaluation or Product License), or the sample code provided in the
SNiFF+ package. If you do not have an Evaluation or Product license,
you will have to use our sample code.

Please be aware that if your software system is huge, you will be faced
with a certain setup-time overhead while SNiFF+ parses everything and
generates all the necessary information.

Although our sample code also demands some setup-time overhead, it
should not be too painful, and it is big enough for getting to know
SNiFF+’s capabilities.

7.5 Import Source Code

■ In the Welcome to SNiFF+ dialog, click the Start button.

The Project Creation Wizard appears. The Project Creation Wizard
guides you through the process of importing code into SNiFF+. Once the
Wizard knows the source code location, it uses file system information to
create a SNiFF+ Project.

Sample Code

References specifically to the sample code provided with
SNiFF+ will appear in boxes like this one. So, if you use the
sample code, look out for these boxes.

The C++ sample code, filebrowser, is based on the ET++
public domain class library. ET++ is an object-oriented applica-
tion framework developed by the University of Zurich and the
UBILAB of the Union Bank of Switzerland.
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7.5.1 Step 1: In the Wizard’s Opening Page

The first question you are asked is:

■ “Do you want to use a version control tool for this Project?”

In this guide, we assume that you want to browse code, and not worry
about anything else. For information on how to create and work with
version controlled Projects, please refer to the SNiFF+ Beginner’s
Guides.

■ Accept the default (No), and click Next.

7.5.2 Step 2: Where is the Source Code?

You need one common root directory that holds all the sources you want
to browse.

Don’t worry about any other (unrelated) directories that may also be
below this root; you can later exclude any unrelated directories.

In the following, we will refer to this directory as Source Root.

■ Use the Browse... button to navigate to the Source Root directory, open
it, and click Select.

Sample Code

For the C++ sample, navigate to

SNIFF_DIR4/examples/cpp/filebrowser/
■ Note that throughout the documentation we refer to your

SNIFF+ installation directory as SNIFF_DIR4.
■ Note also that we use forward slashes (/).

If you are working on Windows, you would of course use
backslashes (\) in paths.
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■ Back in the Wizard, click the Exclude... button.

This opens a dialog showing you the Project structure that will be
created.

If you do not want to include certain directories in the Project, click the
checkboxes to clear them.

Tip: If you collapse a tree node and checkmark/clear the collapsed node,
the setting applies to all subnodes under the collapsed node.

When you are satisfied with the tree, click OK.

Note that, once the Project has been created, you can always rearrange,
add, or remove Subprojects.

■ When you’re ready, click Next.

Sample Code

For the sample code, you
need all directories/
Projects, so leave them all
checkmarked.
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7.5.3 Step 3: Review File Types

The Wizard scans the location you specified, and displays two lists:

Figure 7-1 Wizard—Review File Types

These lists show File Types and file extensions that SNiFF+ has found
and (not) recognized. By default, only those File Types that SNiFF+
“knows” are imported.

What is a “Recognized File Type”?

In the Wizard’s Review File Types page, the left list shows File Types that
SNiFF+ matches with the default file extensions set in the Preferences,
File Types node. That is, SNiFF+ knows what to do with them (which
parser, compiler, etc. to use). By default, only those files that are found
and recognized (left list) will be included in the Project.

Sample Code

Accept the File Types that SNiFF+ knows/does not know, and
click Next.
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Add, Remove, or Modify File Types

Any modifications you set in this dialog will apply only to the Project you
are currently creating. That is, if, for example you add a signature (can be
any character pattern, not just an extension) to a known File Type, only
this Project will know about the new signature; future Projects will not
recognize the new signature.

■ You can use the Add... button to add, or create, File Types. However, we
recommend that you leave these things for later.

■ You can select a recognized File Type and click Remove... to exclude
files of the selected Type from the Project, even though these exist in the
directory tree you specified.

■ Use the >> and << buttons between the lists to add/remove signatures to/
from known File Types.

A situation where you would add a signature to a known File Type would
be where you have files containing, for example, normal ANSI C code,
but with an “exotic” file name extension.

● To add such an “exotic” signature to a known File Type, select the sig-
nature in the right-hand list, and the appropriate File Type in the left
list, then click the << button.

● To remove a signature from a known File Type, select the File Type in
the left-hand list, and click the >> button. A dialog will appear allowing
you to select specific signatures to remove from this Type.

■ When you are satisfied with the File Types to be included in your Project,
click Next.

7.5.4 Step 4: Create Project

The final Wizard page suggests a name for the Root Project, and a loca-
tion where Project information and other SNiFF+-generated files can be
stored.

■ If you are not happy with the suggested names or the location, go ahead
and change them.

● If you change the location, you need write permission for the new
location.

■ When you’re ready, click Finish.
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Cross-Reference Information

Before the Project opens, a dialog box asks you if cross-reference infor-
mation should be generated.

Setting up cross-reference databases may take a while, depending on
the size and nature of your code, as well as your hardware. If you do not
generate cross-reference information immediately, you can do this later
using the menu, Project > Cross-Reference. The information will also
be automatically generated (updated) as soon as you issue a cross-refer-
ence query. In this tour you will be using the Cross-Referencer, so you
might as well allow SNiFF+ to generate the necessary databases imme-
diately.

■ Click Yes.

■ When all information has been generated, the Project is opened in the
Project Browser.

7.6 What Next?

You are now all set to browse your code. We suggest that you go through
the SNiFF+ Beginner’s Guides where you can get to know the SNiFF+
browsing tools and navigation features. The SNiFF+ Beginner’s Guides
go on to describe how to use sample code in a hands-on tutorial for set-
ting up, building, and debugging targets. You will also learn how to cre-
ate a version controlled Project and apply basic version control
commands. Finally, it also covers an outline of procedures for setting up
a team work-organization.

For detailed information about using features of SNiFF+ such as Working
Environments, Project Management, Build System and Configuration
Management, see the SNiFF+ User’s Guide and Reference.

For GUI and menu related information, see the SNiFF+ GUI and Menu
Reference.

All SNiFF+ documentation is available online, under the Help menu.

The manuals are also provided in PDF format in your SNiFF+ installation
directory, docs subdirectory.
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A.1 The SNiFF+ Documentation Set—Guidelines

This manual is part of the SNiFF+ documentation set, and this chapter
offers a few guidelines as to what you can expect to find where in the
documentation.

Most SNiFF+ documentation is available online, under the Help menu.

If you have installed the documentation package, print-formatted PDFs
are located in the docs subdirectory of your SNiFF+ installation.

A.1.1 Beginner’s Guides

Two Beginner’s Guides, one for C/C++ Projects, and the other for Java
Projects, should help to get you going.

Examples, tips, and hands-on how-to descriptions introduce you to many
aspects of using SNiFF+.

The Beginner’s Guides are divided into four major sections.

■ Browsing Tour

Create a Project to browse either your own source code, or sample code
provided with SNiFF+. Get to know the SNiFF+ browsing tools and navi-
gation features.

■ SNiFF+ PRO: Build and Debug Tutorial

Use sample code in a hands-on tutorial for setting up, building, and
debugging targets.

■ CMVC—Configuration Management and Version Control

Create a version controlled Project and apply basic version control
commands.

■ Working in Teams

An outline of procedures for setting up a team work-organization.

A.1.2 User’s Guide and Reference

The User’s Guide and Reference provides more in-depth information
than the Beginner’s Guides. Topics covered include:

■ Fundamental SNiFF+ concepts: Projects and Working Environments

■ Working Environment and Project management

■ How-to guides to procedures

■ Technical descriptions of various subsystems (e.g. Build System)

■ Version Control and Configuration Management
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■ Integrations of version control tools, editors, the VisaJ GUI Builder, and

other tools

■ Regular expression usage in SNiFF+

A.1.3 GUI and Menu Command Reference

This is a reference to functionality of graphical user interface elements
and menu commands. This is also accessed when you use the Context
Help (<F1>).

A.1.4 Migration Guide

An aid for migrating from SNiFF+ 3.x to SNiFF+ 4.x.

This paper is not accesible from the Help menu. If you have installed the
documentation package, migration.pdf will located in the docs
subdirectory of your SNiFF+ installation.

A.1.5 Tornado Integration Guide

Examples, tips, and hands-on how-to descriptions introduce you to many
aspects of using the SNiFF+/SNiFF+ PRO Tornado Integration.

The Tornado Integration Guide is divided into five major sections.

■ Installation

Install the SNiFF+/SNiFF+ PRO Tornado Integration.

■ Integration of Tornado with SNiFF+ (Tornado centric)

Launch SNiFF+ and automatically generate SNiFF+ Projects. Use
SNiFF+ as a "browsing plug-in" in Tornado.

■ Integration of SNiFF+ PRO with Tornado (SNiFF+ centric)

Manage and build Tornado/VxWorks Downloadable Components in
SNiFF+. Debug SNiFF+ built applications on a VxWorks Target using the
SNiFF+ Debugger Adaptor (Tornado II only).

■ CMVC—Configuration Management and Version Control

Version Control Tornado-generated Projects in SNiFF+.

■ Working in Teams

An outline of procedures for setting up a team work-organization.
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A.1.6 Getting Started, Release Notes, Application Papers

Getting Started guides you through installation on Unix/Windows

Release Notes include important, late-breaking information on the cur-
rent release.

Application Papers provide additional information on topics not covered
in the standard documentation.

A.2 Feedback and Useful Links

Feedback

Your feedback is always very welcome.

Please send feedback to one of our support e-mail addresses.

■ Europe

support-ec@windriver.com

■ USA

support@windriver.com

Useful Links

■ A number of useful links (Knowledge Base, FAQs, User’s Mailing List ...)
are available under:

http://www.windriver.com/sniff
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